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特稿   

田蔚风副校长在第四届读书月闭幕式上的讲话 

各位老师，亲爱的同学们： 

在图书馆和同学们的共同努力下，今天第四届“品经典·享书香”读书月活

动顺利闭幕。为庆祝“4·23”第 21 个世界读书日这个庄严而神圣的日子，提高

大家对读书的重视，让更多的人漫步于书廊下，畅游于书海中，图书馆开展了丰

富多彩的阅读推广系列活动。 

这些活动得到了老师和同学们的广泛关注，极大地丰富了校园文化生活，对

推进书香校园建设，提升师生人文素养起到重要作用。为此，我谨代表学校党政

领导对此次读书月活动表示充分的肯定，向此次活动的主办单位图书馆表示衷心

的感谢。 

书籍是人类共同的精神财富，阅读是与圣贤智者在时空上进行的谈话。一本

好书往往能改变人的一生，一个人的精神成长，与他的阅读息息相关。阅读使我

们的精神不再贫乏，思想不再苍白，生命不再孱弱，人生不再孤独，让我们成为

有信念、通情理、明是非、知荣辱的人。图书馆是学校的文献信息资源中心，是

校园文化建设的重要组成部分，以其专业性、权威性和资源性而成为阅读推广的

重要阵地，在每年的读书日前后举办多种形式的读书推广活动，激发学生的求知

欲望和阅读热情，培养其阅读习惯，在上理形成一股“爱读书、读好书、善读书”

的良好风尚。 

书香润泽校园，阅读丰富人生。读书月活动的闭幕并不意味着阅读行为的结

束，我们应借此契机，点燃阅读热情，根据自己的专业和爱好，制定有效的阅读

计划，充分利用图书馆的馆藏优势，经常到图书馆来借阅自己喜欢的图书并阅读，

尽享阅读乐趣，使阅读成为我们上理最富浪漫与温情的一道风景。 

以书为媒，相约书香；亲近书本，回归阅读。最后，我倡议广大师生从我做

起，让终身学习、毕生阅读成为自觉追求，共同打造书香上理。 

（责任编辑：王细荣） 
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图书馆工作   

愿每一位上理人都能收获幸福 

——王宏光馆长对第四届读书月的总结 

尊敬的田校长，各位来宾，各位老师，各位同学： 

大家下午好！ 

在这丁香花盛开的季节，能与各位在知识殿堂里相遇、相见、相知，是一件

值得举杯的事情。首先我代表图书馆全体同仁感谢大家在百忙之中出席第四届读

书月闭幕式，同时恭喜你们在读书月期间与知识擦出了爱的火花。 

在暖风拂过的四月，我们图书馆携手“图书馆之友”协会拉开了“品经典·享

书香”读书月主题活动的序幕。一个多月的时间里，我们共策划组织了 15 项大大

小小的主题活动。为了使活动更加多元化，我们在活动开始之前就面向全校师生

征集创意活动方案，在收集的这些方案里，各种奇思妙想让我们看到了集体智慧

带来的无穷光亮。我们保留了过去读书月中的“关注图书馆微信免图书逾期罚款”

及“你选书我买单”等传统项目，让这些实实在在的实惠继续飘扬；为了让更多

的人认识图书馆的特色及便利服务，我们设计了一份轻松的读者问卷，及时了解

读者们的需求，我们还定制了一套目前已遍布整个校园的一卡通卡套。同时，我

们深知知识互动带来的传播力和感染力，为此我们举办了“百十校庆——向经典

致敬”朗诵比赛，“最美是阅读”原创摄影比赛、“同读一本书”阅读分享会及图

书漂流等活动。活动中，那些活泼的身影让我深感分享是如此幸福。我们收到很

多或温馨，或中肯的反馈，心里很感激大家对图书馆的关注。 

另外，“图书馆之友”协会也带来了“方寸世界蕴书情”书签设计、图书寻宝、

最美阅读读书交流会等活动，数据库商也带着同学们进行移动体验活动，让我们

的阅读不再受时空的限制。“迎春暖，赏百花，观江楼台望江月；品经典，享书香，

文山墨海话人生。”在图书馆这座浩瀚的天堂里，你与我之间的距离不再遥远，望

江月，话人生，也便是惬意的相约。 

老师们，同学们，读书月今天就要落下帷幕了，但我相信只要心中一直拥有
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阅读这颗不陨的行星，它将永不逝去。今年我校将迎来 110 周年华诞，过去的百

十年，我们从未离弃，未来，我们依然紧紧相依。丁香点点，诗意悠悠，衷心祝

愿每一位上理人在这里都能收获幸福。 

谢谢大家！ 

（责任编辑：吕玉龙） 

2016 年 IEL 数据库高校用户会纪实 

2016 年 4 月 13-15 日，由 IEEE 和 iGroup 公司联合举办的 2016 年 IEL 数

据库高校用户会在杭州隆重召开。本次会议受到了全国各地高校图书馆以及

DRAA 的大力支持与关注，有来自近百所高校图书馆的百余位馆长、图书馆员

参会。 

IEEE 平台设计高级总监 Prakash Bellur 先生、IEEE 客户培训总监 Rachel 

Berrington 女士、IEEE 亚太区销售经理 Patrick Leung 先生、IEEE 中国区资讯

经理李箐女士及 iGroup 公司中国区经理赵云先生作为嘉宾出席了 4月 14 日上午

的全体会议。iGroup 公司中国区副总经理汤华骏先生、DRAA 牵头馆代表上海交通

大学图书馆副馆长林皓明先生也一同出席并致欢迎词。 

会上，IEEE 与会嘉宾介绍了 IEEE Xplore 平台的最新动态、新增功能及 DRAA

组团方案，同时分享了图书馆合作创新案例等内容。在 4 月 15 日上午召开的 

InnovationQ Plus 专利分析工具座谈会上，IEEE 中国区资讯经理李箐女士介绍

并现场演示了 IEEE 新产品 InnovationQ Plus 专利分析工具的功能及特点。座谈

会过程中，与会代表们积极交流，踊跃发言，对新产品提出了宝贵建议及意见。 

IEEE 是全球知名电子技术与信息科学工程师协会，其数据库产品 IEL

（IEEE/IEL Electronic Library）主要涉及电气电子、航空航天、通讯工程、计

算机、纳米技术、电力等领域。自 2001 年进入中国高校以来，IEEE 为中国的学

者和研究人员提供了世界领先的科技信息。我馆自 2011 年 9 月开通使用以来下载

总量达到 224531 篇，登录访问人次达到 126870 次，为我校读者的教学、科研提

供了大量信息。此次会议，加强了高校用户和数据库商之间、用户与用户之间的
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交流和了解。该数据库的采购和使用，进一步提高了我校文献资源利用率。 

（供稿：流通部  宗  良/责任编辑：吕玉龙） 

参加“中文在线”上海高校图书馆阅读推广分享会有感 

阳春三月，草长莺飞。在这和煦的春日里，华东师范大学图书馆召开了由“中

文在线”联合上海高校图工委文献资源组共同举办的上海高校图书馆阅读推广分

享会。此次会议旨在提高高等教育阶段数字阅读的质与量，扩大在校师生的阅读

方式与手段，丰富各高校的阅读推广方式，活跃校园读书文化。 

会议首先由上海图工委常务副秘书长林晧明致辞，对即将到来的4月23日“世

界读书日”进行预热，并介绍了上海高校对“书香校园”等一系列数据库的联合

采购情况。林副秘书长以“大公报”和“试题库”两个成功完成的上海地区高校

联合采购项目为例，言简意赅地总结了数字化资源相对于传统纸质资源的优势以

及联合采购相对于传统单独采购的长处，号召到会同仁在高校图书馆的日常工作

中重视联合采购项目，提高在图书馆资金使用方面的投入产出比。 

“书香校园”是“中文在线”旗下的主推产品，也是我馆购买的数据库之一。

分享会中该数据库相关讲师为我们培训了“书香校园”平台的相关模块和使用流

程，详细讲解了在线阅读活动制作的操作方式，着重分享了近期成功举行的在线

阅读活动案例。作为国内数字出版行业的领军企业，北京中文在线数字出版有限

公司建设了以“书香校园”为首的高校数字阅读平台，其特色在于引入了有声图

书这一数字化资源，并且添加了在线阅读活动、社区交流、书评分享等深受年轻

人欢迎的网络交流方式，与当今提倡的“互联网开放式图书馆”、“终身图书馆”

等理念遥相呼应。 

最后是华东师范大学图书馆馆员分享其图书馆主题书展的心得体会。如何将

图书馆的物理空间与网络空间进行有机结合，如何将备受冷落的纸本图书重新流

通起来，如何调动学生的读书热情与参与积极性……听罢华师大主题书展的分享，

其中别出心裁的创意、简单质朴的讲解、切实可行的操作，均对我馆开展主题书

展活动有很大的启发。 
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分享会的内容紧凑充实且与高校图书馆的日常工作息息相关。一下午的分享

时间虽然很短暂，但对我们图书馆员工作的触动尤为深远，期待着下一次分享活

动的举办。 

（供稿：流通部  徐梦琪/责任编辑：苏丽丽） 

文献利用  

“CALIS 第十四届引进数据库培训周”的启示 

2016 年 5 月 10 日，由中国高等教育文献保障系统（简称 CALIS）管理中心和

高校图书馆数字资源采购联盟（简称 DRAA）联合主办的引进数据库培训周活动在

兰州大学拉开帷幕。 

作为中国图书馆界颇具影响力的培训活动，本届参会人员由三十多家国内外

数据库商和超过两百多所全国各地高校图书馆的代表组成。嘉宾紧密联系图书馆

工作发展现状和文献信息检索学科前沿的演讲，给我们留下了深刻的印象。其中，

北京大学的刘雅琼馆员以车载电池领域的研究态势分析为例,厦门大学的林静副

研究馆员以该馆为航空航天学院提供基于多学科交叉融合的科研选题分析为例，

各自展示了通过文献计量、引文分析等方法利用数字资源发现科研热点，辅助科

研选题，实现了图书馆的主动服务、深化服务。 

下面结合这两场报告提供的主要工作流程，对他们使用的分析软件和数据库

平台自带工具进行梳理，希望能给各位老师和同学们在工作学习中利用文献数据

带来一点启示。 

1. 文献检索 

科研工作常常涉及到鉴定成果、评估人才，因此学科服务少不了对项目影响

力、学科竞争力、科研产出以及科研工作者本身进行分析和评估。通常数据来源

有：WOS、SCOPUS、CNKI 的期刊、会议论文，以及 WOS-DII、INNOGRAPHY 和国家

知识产权局的专利数据等。根据具体研究需要选定调查范围，初步检索研究主题，

根据论文的发表情况，确定一个合适的检索时间范围。接下来就可以从查找出的
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重点文献中提取关键词。在报告的两个案例中，馆员团队分别征询了专家意见，

以及根据课题前期调研和国家科研工作规划纲要确定主题词。 

2. 文献计量与分析 

进行完检索工作后，统计分析各项数据就成了重点。北大的案例中，涉及到

多个指标，如发文量、被引频次、引文影响力、高被引论文量等，也涉及到多个

评估学科竞争力的维度，如国家/地区、机构、人员等。在计量过程中主要使用了

InCites 平台。该平台在整合 ESI 和 JCR 的功能后更强大，可以无缝连接 Web of 

Science，导入数据更方便，个人、机构、区域的学术能力报告可以一键式生成。 

3. 趋势与热点提炼 

两个案例均使用了多种软件工具对文献数据进行了提炼。针对如何综合运用

多个数据平台和文献工具，以及如何对所有分析结果进行整合，这一难点也有各

自的应对方法。以下是被多次提到的几种工具： 

3.1 TDA 

Thomson Data Analyzer (TDA)是情报挖掘和分析软件，它本身不包含任何数

据，也不检索任何数据库。数据导入 TDA 后，可以对文本数据进行多角度的数据

挖掘和可视化分析。 

TDA 能够帮助我们从大量的专利文献或科技文献中发现竞争情报和技术情

报，为洞察科学技术的发展趋势、发现行业出现的新兴技术、寻找合作伙伴、确

定研究战略和发展方向提供有价值的依据。案例中用到了 TDA 的高频关键词分析。 

3.2 CiteSpace 

CiteSpace 是一款可视化文献分析软件，能够显示一个学科或知识领域在一

定时期发展的趋势与动向，形成若干研究前沿领域的演进历程。核心功能是产生

由多个文献共被引网络组合而成的一种独特的共被引网络，以及自动生成的一些

相关分析结果。我们可以将 web of science 的数据导入 CiteSpace 自带的数据

库，然后检查，更改数据，最后输出整理后的数据。使用该工具需要一定的 SQL

基础。案例中采用 CiteSpace 对数据进行了共词分析。 

3.3 ESI 
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Essential Science Indicators（ESI）是基于 web of science 平台，展现

科研绩效统计与科研发展趋势的数据库。可以按照 22 个宽泛的学科领域，对国家、

机构、期刊进行排名。也可以利用 ESI 进行科研文献分析，定位顶尖科学家、顶

尖机构；定位科研发展趋势和新兴研究方向，评估有潜力的合作伙伴、审稿人与

同行机构；定位某学科最新、最热研究论文等。 

3.4 INNOGRAPHY 

Innography 可以将专利、商业、诉讼等各方面信息结合在一起形成结构化分

析方案，以可视化图表形式直观地呈现，如专利强度分析和相似专利分析。专利

强度分析可以迅速地从海量的专利数据中筛选出核心专利，集中注意力到高价值

的文献领域，这正是专利文献利用的前沿方向。 

3.5 Scopus 

Scopus 是全球最大的、同行评审的文摘及引文型文献数据库，涉及领域包括

自然科学、工程技术、医学、社会科学以及艺术人文等学科。该库也自带多种文

献计量工具帮助用户对科研内容进行跟踪、分析和可视化研究。 

本次会议期间，图书馆学领域的相关专家、数据库商和图书馆代表共同交流

经验，探讨问题，提供解决方案，分享学术前沿。通过参加此次培训，笔者对数

据库商的服务资讯有了进一步的了解，对于整个中国高校图书馆界的科研动态有

了全面的解读，对本校图书馆今后工作的规划有了新的视点。 

（供稿：采编部 葛冬琳，流通部  徐梦琪/责任编辑：丁  洁） 

JabRef 文献管理软件使用方法 

JabRef 是 一 个 开 源 的 参 考 文 献 管 理 软 件 （ 官 方 网 址 ：

http://jabref.sourceforge.net/），使用 Java 语言编写，所以天生具有跨平台特性，

通用于安装有 Java 的 Windows, Linux 和 Mac 系统。它可以很方便地管理下载

到本机的文献，生成 BibTeX 文献数据库，供 LaTeX 或其它软件使用，可以与 

Kile、 Emacs、Vim、WinEdt 等多种软件结合使用。 

JabRef 最大的特点就是使用 BibTeX 格式的数据库，所以它最适合 LaTeX 用
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户使用；如果仅仅使用它的管理功能，也可以用于本地电子书的管理；对于使用

MS Office 写论文的用户来说，EndNote 是最好的选择，它能集成到 MS Word 中，

所以不推荐使用 JabRef。 

基本使用指南： 

1. 打开软件。新安装的软件，只有软件菜单和工具栏，其他空白（如图 1）。

图 1                                           图 2                              

 2. 单击工具栏左侧第一个图标，工具栏下方出现带表头的区域，单击“New 

database”（如图 2）。 

3. 点击“Web Search”菜单，选择“Search IEEEXplore ”。注意左边出现有

搜索功能区。在光标闪烁的地方输入关键词。这里演示输入的是“Notes on the 

simulation of evolution”，单击“Fetch”（如图 3）。 

 

图 3 

 选择需要的文献，单击下方的“OK”。查到的结果转移到了刚才新建的“数

据库”中（如图 4）。 
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图 4 

基本界面介绍。两个新分隔区：表格状的是文献题录显示区，显示的是整个

文献数据库，每行是一条文献（专用术语是“题录”，英文称为 entry）；它下方的

分隔区域是文献预览区（entry preview），显示的是当前选中的文献信息。可以用

“View”菜单下的“Toggle entry preview”显示或隐藏文献预览区。 

再看一下数据库的表头（栏标题）。#号表示文献排序号。Author 是作者，它

左边的图标表示该文献有网址链接，单击可以打开浏览器查看链接中的文献信息。

Title、Year、Journal 等为常用项。有三个较陌生的 Owner、Timestamp 和 Bibtexkey。 

4. 修改 Bibtexkey 设置。打开“Options”（选项）菜单的“Preferences”（偏

好设置），点击弹出窗口左边“BibTex key generator”切换到该标签页（如图 5）。 

 
图 5 
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演示用的是[year]-[auth]-p[firstpage]-[lastpage] （表示：“年”-“第一作者姓”

-p“文章首页”-“文章末页”，在帮助页里面能了解到每个词表示的意思），把它

放到右边第一行内（Default pattern）。注意，刚才设置的 Bibtexkey 尚未起作用。

需要手动更新：点中其中一条文献，然后用 Ctrl+A（同时按下 Ctrl 键和 A 键）全

选，再点“Tools”菜单下的“Autogenerate BibTex keys”，全部 Bibtexkey 得到更

新。 

5. 下载和关联全文。先建立一个存放文献的文件夹（演示使用的是

E:\Reference\JabRef）。同样点击“Options”下的“Preferences”，选中“External 

programs”，把“Main file directory”设置成刚才建立的文件夹位置，并且选中“Main 

file directory”下面第一个选项（如图 6）。 

 
图 6 

 设置完毕点“OK”回到主窗口。文献预览区第一行的括号里面的内容就是

Bibtexkey。选中，Ctrl+C 拷贝它。点击作者左边的网址图标，跟踪到它的全文 pdf

网址，打开 pdf 文件以后另存到刚才建立的目录，文件名使用刚才拷贝到的

Bibtexkey，扩展名不变。现在可以关联文件了。“Tools”—>“Scan database...”

—>“Synchronize file links”，适当看看弹出的窗口，然后点“OK”，很显然，有全
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文的文献多了一个图标（如图 7）。 

 

 
图 7 

说明：管理文献条目  

文献数据库的条目建立起来了，但是这只是一些 citation 和 abstract 信息，那

么如何将下载的论文 pdf/ps 文件和它们对应的条目关联起来呢？ 

只需要将下载论文的文件名保存成特定的格式，一种方法是文件名中包含

BibTeXkey ， 比 如 是 A. Yao 在 2005 年 发 表 的 文 章 ， 文 件 名 就 起 为

xxx-Yao2005-yyy.pdf；一种方法是文件名包含论文名。 

然后修改匹配规则：Options->Preferences->External Programs->Use Regular 

Expression Search 文本框，比如在当前目录下匹配包含 BibTeXkey 的文件：

“ ./.*[bibtexkey].*\\.[extension] ”，在当前目录下匹配包含论文名的文件：

“ ./.*[title].*\\.[extension] ”， 在 子 目 录 中 匹 配 包 含  BibTeXkek 的 文 件 ：

“**/.*[bibtexkey].*\\.[extension]”。如果把文献数据库 bib 文件和 pdf 文件放在同

一目录下，只需要使用在当前目录下匹配即可。 

修改完文件名和匹配关系，就可以将论文记录关联到文件。如果是一次导入

很多文献，可以使用批量处理：Tools->Scan database->Sychronize file links，但是

同步的时候不要选择 Check existing file links，那样会很慢；处理单一记录的方法

是：双击某论文条目，或者选中后按 Ctrl+E，就可以编辑该条目。进入 General 选

项卡，在 File 条目后面点 Auto，JabRef 就会按照匹配规则搜索匹配的文件，关

联到该条目。如果能搜索到 pdf 文件，关联后该条目的前面会出现一个 pdf 图
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标，点击该图标，就可以直接打开该论文的 pdf 文件。除了自动匹配以外，也可

以使用 Auto 旁边的 + 号手动添加文件。 

也可以编辑文献条目的其它信息，比如 ACM 的 BibTeX 中往往不包含摘要

信息，可以在按下 Ctrl+E 以后的 Abstract 选项卡中添加对应论文的摘要信息；

Springer 的 RIS 信息往往过于简单，也可以通过网页信息添加一些条目；如果对

某篇文献有深刻印象或者想记一下笔记，可以在 Review 选项卡中记录下自己的

想法。 

在一个文献数据库中，文献还可以分组。View->Toggle groups interface，可以

新建、修改分组，这样有一个好处是可以将该数据库所属大方向的很多小方向分

组浏览，对初期准备了解研究方向大致轮廓的研究人员很有帮助。 

6. 保存文件。演示用“Reference”作文件名，默认扩展名是 bib。在工具栏

下会看到文件名（如图 8）。 

 
图 8 

 7. 在 WinEdt 中使用 JabRef。在 WinEdt 编译环境中适当位置插入以下演示

语句（如图 9）： 

\usepackage{bibentry}（通用） 

\bibliographystyle{elsarticle-harv}（演示使用）  

\bibliography{Reference}（演示使用） 
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图 9 

在需要插入文献引用处单击 JabRef 窗口按钮如下，可自动生成文献引用，如

下图所示（如图 10）。 

 

图 10 

 注意：要将 WinEdt 的运行文件与 JabRef 关联起来（如图 11）。 

 

图 11 
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 编译 LaTex 运行效果（如图 12）。 

 
图 12 

（供稿：参考阅览部  李仁德/ 责任编辑：郭培铭） 

馆员读书   

知识流动开创图书馆的“蓝海” 

——读吴建中先生的《知识是流动的》 

我国东汉思想家王充在《论衡·效力篇》中提出“知为力”的论点。1500 年

后的英国著名的唯物主义哲学家弗朗西斯·培根（Francis Bacon）在其《伟大的

复兴》第二部分（他自称为《新工具》，1620 年出版）中宣称：“人的知识和人的

力量合二为一……达到人的力量的道路和达到人的知识的道路是紧挨着的，而且

几乎是一样的。”① 王充这个论点和培根的这两句话，被后人概括成一句口号“知

识就是力量”。这句口号国人耳熟能详，而且甚是认同。最近，阅读吴建中先生新

著《知识是流动的》（上海远东出版社 2015 年 8 月出版，以下用“此书”指称），

感觉“知识就是力量”这句名言有必要修正为“知识流动才会有力量”。 

吴先生在此书中，从大数据之“取”的视角，以图书馆战略研究者的眼光对

知识流动的特性进行重新审视，并从知识与人的关系出发，阐明知识流动的机制、

作用、环境和意义。不过，笔者在阅读此著后，感悟最深的是，本书为图书情报

                                                        
① 北京大学哲学系外国哲学史教研室. 西方哲学原著选读(上)[M]. 北京:商务印书馆, 1981:345, 347. 
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工作者描绘了一幅未来工作的蓝图：图书馆人与出版界、学术界甚至每一个网民

携手合作，通过知识的释放、知识的关联、知识的疏通、环境的营造、知识的开

放、知识的分享等途径，提高知识尤其是非常规资源的能见度、关联度、流畅度、

传播力、开放度、共享度，从而促进知识流动并增值，即让知识的能量最大程度

地释放出来。 

1. 知识的释放 

如今的非结构化或半结构化数据、暗数据、零次情报、灰色文献等非常规知

识资源将占越来越大的比重，但大都处于封闭、分散、孤立的状态，且容易流失。

非常规资源是相对于图书馆可物化、统计、收藏和编目的常规产品知识资源而言

的，指的是信息资源中那些非常规、非结构化的东西，即所谓真正意义上的大数

据。根据数字宇宙的调查报告、IBM 公司的估计、EMC 公司的调查结果，吴先生列

出一些如何将这些资源释放、揭示出来的实例（如暗数据的挖掘）。触类旁通，举

一反三。面对这些有着巨大潜能的大数据，我们图情工作者也应有所行动，如独

自或与其他相关专业人士合作，对这些尚未流动起来的非常规资源进行挖掘、链

接、标引、分析、保存、保护，让它们变成永存的流动知识，进而释放其潜在的

价值。 

2. 知识的关联 

吴先生指出：“让知识流动起来，不仅要将它们从分散、孤立的状态下释放出

来，而且要将它们有效、有序地关联起来。”知识的关联，离不开关联数据这种技

术。关联数据是国际互联网协会（W3C）推荐的一种规范，本质上是将超文本链接

（即文件之间的链接）转变为超数据链接（即 Thing 之间的链接）的一种技术框

架。关联数据克服了以索引为基础的传统资源编目的局限性，并能让数据反复利

用和增值。自从 2008 年瑞典国家图书馆以关联数据的形式发布了 LIBRIS 国家书

目以来，此项技术在全世界已有许多实践案例，并逐渐走向成熟。因此，我们图

书馆人要改变传统的资源描述方式，与领域专家、内容管理专家和网络应用开发

人员等合作，自觉地关注图书馆资源与外界资源的关联，让数据与其他数据关联

起来，最终为用户打造一个开放、关联的知识网络。 
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3. 知识的疏通 

像运动是物质的根本属性一样，流动是知识（信息、数据）的生命力所在。

在本书第三章“流畅”中，吴先生以流媒体、世界数据流和量化自我等为例，介

绍了“疏”之于知识流的作用与意义。耶鲁大学教授戴维·格勒恩特（David 

Gelernter）提出的以时间为基础的“世界数据流”（worldstream）观念具有前瞻

性，因为它为大数据的流动描绘了一幅美好的蓝图。现在的网络以空间为基础，

需要标记特定位置的网址（URL），其中流动的知识被人为地切断，变成了一篇篇

独立的文档、一个个独立的系统，虽然相互间可以链接，但无法自由流动。如果

现在的网络被“世界数据流”所代替，那么计算机的主要功能就是接入不断流动

的全球网络数据流，之前以文档形式出现的信息会以信息流出现，会根据人的需

要动态地聚集在一起。另外，“世界数据流”的流动形式与人的生活方式相通，丰

富了人际交流尤其是人与人之间的感情交流。“增强知识的流动性，一靠加大人际

交流的频率，二靠畅通信息传输的渠道。”①“世界数据流”为这一切提供了无限

的可能，也为图书情报工作者提高知识的流畅度指明了努力的方向。 

4. 环境的营造 

本书第四章所讲的“环境”主要指人类知识交流的空间、技术及工具。如果

这种环境良好，空间、技术和人三者处于和谐状态，知识的流动才会顺畅。在大

数据时代，一种虚拟与实体相互影响与融合形成的新型空间形态：流空间（Space 

of flows），打破了固定可见的局限性，激励人们借用开放且无限延展的网络的力

量，促进了信息流、人流等跨越时空地流动，从而为知识无边界、无障碍地传播

带来无限的可能性。高铁等现代化的交通工具、以宽带为代表的信息基础设施、

人口流动与人才循环等，加大了人际交流的频率，提升了信息传播的速率，促进

了知识的流动速度。在消除人与人之间距离的“流空间”、方便人际交流的新技术

和现代化工具已经成为现实时，图书馆人如果能为知识的流动营造一个合适的环

境，做一些力所能及的事情，那么作为知识流动主体的人便会朝着积极的方向流

动，而这对促进知识的流动不能不说是一件有意义的事情。 

                                                        
① 吴建中. 知识是流动的:出版界与图书馆界的新课题[J]. 图书馆杂志, 2015, 34(3):4-11. 
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5. 知识的开放 

本书第六、第七章的核心议题是“要推动知识最大限度地开放”。21 世纪以

来，国际学术界、图书情报界引领了一场轰轰烈烈的推动科研成果通过互联网免

费、自由地利用的开放运动。近年来，开放运动也不断向纵深发展，即进一步推

进以开放数据为中心的科学开放。为此，有学者建议，英国科学家法拉第（M. 

Faraday）的“三词箴言”：Work（实验）、Finish（完成）、Publish（发表）应有

所拓展，即在“三词箴言”的基础上还要增加一词“Release（网上发布）”，意思

是实验结果完成后发表还不够，还要把它发布到网上，以确保论文的生命周期得

以延长，使论文更多的内容与数据被揭示出来，并得到再次利用。面对开放已成

为一种全球共识，图书馆需要与政府部门、各类研究基金会、大学及研究院所、

民间非营利机构、学协会、国际机构以及研究者等合作，尤其需要与出版机构的

合作，共同站在开放科学运动的前沿，实现图书馆与出版者的互惠，正所谓“通

过支持创新、实验和先导项目，在共同构建学术出版物开放获取体系中将获得双

赢的效益”。 

6. 知识的分享 

“知识流动的基础是开放，开放是为了更好地交流和分享。”① 本书第五章讨

论了知识共享与知识产权保护之间的张力，分析了如何在知识产权保护的框架下，

最大限度地实现知识共享。传统的著作权有两个极端：“保留所有的权利”（All 

Rights Reserved）和“不保留任何权利”（即“公有领域”，Public Domain）。它

们之间有一个灰色地带，即“保留部分权利”（Some Rights Reserved）。目前全

球流行的知识共享协议（Creative Commons Public Licenses，简称“CC 协议”）

为之提供了 4种“保留部分权利”的组合方式：①署名（Attribution, 简写 BY），

②非商业用途（Noncommercial, 简写 NC），③禁止演绎（No Derivative Works, 

简写 ND），④保持一致（Share Alike, 简写 SA）。这样，任何创造性作品都有机

会被更多人分享和再创造，共同促进人类知识在其生命周期内产生最大价值。关

于知识的分享，图书馆人可积极宣传 CC 协议等知识共享的相关协议，力图在知识

                                                        
① 吴建中. 知识是流动的:出版界与图书馆界的新课题[J]. 图书馆杂志, 2015, 34(3):4-11. 
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产权保护和知识共享之间搭建一座桥梁，从而促进知识的传播和流动，最终实现

知识流动的终极目标：知识共享。 

7. 结语 

《知识是流动的》是吴先生对知识如何转化为力量的系列思考，既有理论高

度，又有实践深度，充分彰显他一贯的图书馆战略研究理念：“立足图书馆而又高

于图书馆，立足现在面向未来，立足国内面向世界，立足学术面向实践。”① 其中

的一些思想不仅令人耳目一新，而且对图书馆知识管理实践和图书馆所面临的去

中介化挑战具有引领意义，即大数据时代的图书情报工作者要充分把握知识流动

的规律，顺应以时间为基础的网络形态和以使用为基础的消费模式，为用户方便

“取”得知识创造必要的条件，如知识的释放、知识的关联、知识的疏通、环境

的营造、知识的开放、知识的分享等，进而让图书馆冲破充满竞争的“红海”，开

创一片自由的“蓝海”。由于知识共享是知识流动的最终目的，如果将本书第五章

“分享”置于结尾部分，也许更符合逻辑与历史相统一的原则。另外，在“遗忘

将变成例外，而记忆却成了常态”的数字时代，信息一旦被“分享”，便基本上失

去了控制。因此，如果本书在“分享”之后还有“删除”的内容：舍去无意义的，

或许有助于读者从大数据角度去理解“知识是把双刃剑”。 

（供稿：信息部 王细荣，原载《图书馆杂志》2016 年第 3期/责任编辑：张 佳） 

读者沙龙   

看书，无需等待 

你我都认同读书是一件值得去做的事，在读书这件事上，你花了多长时间？

是的，你忙，忙着学习，忙着工作，忙着生活，忙着忘记了读书。幸运的是，读

书这件事，无论何时开始都不算晚，我在路上，你呢？ 

前几天，阳光温暖，心情很好，我发了一条微博：我最喜欢的生活状态就是

                                                        
① 陈有志. 图书馆战略研究知行合一的演绎者——吴建中先生学术研究概览[J]. 高校图书馆工作, 2012, 

32(1):8-13. 
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骑着自行车去图书馆看自己喜欢的书，等条件允许了，我会在世界的某个角落开

一家书店，养不同种类的多肉植物，偶尔看看喜欢的电影，结交一群朋友。 

对于读书，我有一个不知是好还是坏的习惯，我喜欢很多书一起读，一般是

书桌上和书包里各放一本从图书馆里借的书，床上放一本自己买的书，去图书馆

的时候再看另外一本书，偶尔也用手机看电子书，多的时候六本书一起看，基本

上不是小说就是散文记事书，我不喜欢诗歌，但我喜欢诗词，可惜仅仅是喜欢，

背不下来，有点叶公好龙的感觉。 

读什么样的书往往会产生矛盾，如果你工作了，你是看和工作有关的书还是

自己喜欢的书？如果你是学生，你会看专业参考书还是文学名著？每次去图书馆

之前，我都告诉自己：为了以后好找工作，现在应该多学点技能。有关软件学习

的书基本上在图书馆四楼（自然科学），而我往往爬楼梯到三楼（社会科学）就不

往上爬了，真正吸引我的书在三楼。一天过去了，心里是很满足，但感觉任务还

是没有完成。最近，室友说出了解决的办法：着急的事先做，不着急的事慢慢做。

是的，读书是一件慢事，随时开始，永不结束。有时候，我们意识到该看看书了，

但不知道看什么书，我看的书都是网上推荐的阅读量比较高的书，微博和微信上

有很多推荐书单，这样别人帮我进行了一轮筛选。 

现在书太多了，每本都看是看不完的，也没有那个必要，所以，建议大家看

看经得起岁月考验和读者推荐的书。 

你还在抱怨时代吗？去看看《钢铁是怎样炼成的》和《红岩》，感受鲜血造就

的新时代。我常在想，如果生在战争年代，我会怎么做？我希望自己像柯察金和

江姐一样义无反顾地加入革命，但革命背后的艰辛又是我能承受的吗？我不知道，

生活不是拍戏，遗憾并感谢上帝让我错过了那个动荡的年代。你还在抱怨父母吗？

去看看《许三观卖血记》、《活着》和《平凡的世界》，从出生到现在，我只做了一

件事，那就是读书，而我的爸爸当过医生、农民，卖过猪肉、采过矿、开过车，

养着一大家人，不要因为父辈没有成功而忽略了他们的付出。我妈卖过血，我献

过血，当年不懂事的我用妈妈的血换来的钱无比高兴地去买吃的。当我读《许三

观卖血记》时，我哭了，成长伴随着泪水。摸摸父母的手，老茧刺得我双眼好疼，
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疼得我好想拥抱一下爸妈。你还在抱怨生活吗？去看看《撒哈拉的故事》、《稻草

人手记》和《乖，摸摸头》。三毛是我最喜欢的女作家之一，她的生活就是一本书。

别人过着我们想过的生活，因为他们比常人多了一份勇气。你还在抱怨自己吗？

去看看《你值得拥有最好的一切》、《不畏将来，不念过去》和《人生不设想》。不

幸的人太多，你排在第一吗？如果不是，请继续前进。生活没必要过于矫情，不

对自己狠一点，又怎么能收获你想要的喜悦。 

在古代的女人中，我眼中的古代仅指“君生我未生，我生君已死”的人，我

最欣赏李清照的爱情观和三毛的生活观，不喜欢林微因，她太具有杀伤力。就最

近读的书，对部分作者做个片面的总结：路遥书中的男主总在不停地奋斗，从农

村迈向城市；余华书中的男主很苦情但命长，而配角却很早离去；莫言的书细节

描写很到位，内容总给人一种雾里看花的不真实感；韩寒写的书中话题总离不开

车。纵观现代畅销书籍，要不就是言情小说，要不就是记录别人所经历的不同凡

人的经历，要不就是一针见血地揭穿人类感情后想方设法安慰大众的心灵鸡汤文

章。 

前一段时间，柴静的“穹顶之下”比较火，只是这场火很快被灭了下去。三

十多年前，龙应台在台湾放了一把《野火》，这场野火烧到了政府，烧到了人民，

烧到了龙应台，这场火同样适用于 21 世纪的内地。今天，你生气了吗？为什么不

生气？军工路上尘土飞扬，已到了无力吐槽的地步；自行车道的缺少更加重了我

的无力感。我们没有生气，捂住嘴巴，少年飞驰而过。生气有用吗？我不知道。

宿舍的淋浴完全是个摆设，我提过意见，可惜杳无回音。我们的确是不会“闹事”

的一代，常年在“幼稚园大学”接受教育，像机器人一样看问题。少年，我们的

母亲生了“梅毒”。请不要遮住我的阳光，我们需要不一样的自由，该生气的时候

就生气。同时，推荐龙应台的母爱三部曲：《亲爱的安德烈》、《孩子，你慢慢来》、

《目送》，母爱是一千瓦的灯泡，好亮。 

读书，是一场免费的旅行，性价比这么高的事不做，你还幻想做什么？要么

读书，要么旅行，身体和灵魂必须有一个在路上。读书，无需等待。 

（供稿：管理学院 2014 级研究生  袁少杨 / 责任编辑：张  佳） 
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简讯   

图书馆在上海高校资源发现系列大赛中喜获佳绩 

日前获悉，图书馆在上海市高校图工委、上海市高校图工委文献资源建设工

作组等主办的 2015“知网杯”上海高校资源发现系列大赛中喜获佳绩。图书馆拍

摄的微视频宣传片《一天·一辈子》和《书签·书牵》分别斩获馆员系列比赛“图

书馆员的一天”一等奖和二等奖。“图书馆员的一天”比赛内容为，上海市各高校

图书馆馆员以音乐相册、微视频、电子图书等形式，呈现图书馆各职能部门工作

人员积极向上的精神风貌。 

另外，图书馆还荣获此次系列比赛的“最佳组织奖”。 

（供 稿：信息部 王细荣 / 责任编辑：苏丽丽） 

图书馆举办“SCI——科学引文索引”专题讲座 

2016 年 5 月 10 日下午，为帮助我校师生更深入了解和使用 Web of Science

（SCI）数据库平台，更有效地利用该平台助力科学研究，图书馆邀请汤森路透公

司的培训师张丹丹老师在八楼报告厅做了题为“‘激励发现，推动创新’——利用

Web of Science 助力科学研究”的专题讲座。 

讲座中，张老师首先以“科研问题”为引，介绍了科研中的资料搜集、选题、

开题过程，从而引出 Web of Science（SCI）数据库平台可助力科研的特性。接

着从科研过程的检索、分析、写作、投稿四个方面深入浅出地分析了如何利用该

平台中的检索和分析功能为科研服务，同时张老师建议大家关注高影响力文献，

锁定热点研究问题并跟进所做课题的最新进展，从而能更好地跟随学科前沿做好

科研。 

讲座内容不仅丰富，张老师更是用形象生动的语言将枯燥的科研学习描述得

简单有趣。通过现场互动讨论交流，与会师生在实际学习和科研中所碰到的问题

有了解决的方法，普遍觉得获益匪浅。 

（供 稿：信息部 丁  洁 / 责任编辑：郭培铭） 
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图书馆第四届读书月活动圆满落幕 

2016 年 5 月 24 日下午，图书馆第四届读书月闭幕式在图书馆一楼大厅举行。

副校长田蔚风，图书馆馆长王宏光，副馆长魏林、蒋纯国，相关职能部门领导出

席了闭幕式，图书馆全体员工与广大师生一起共同分享了这一场初夏盛会。 

现场炫目的 LED 电子大屏，清新欢快的签到墙和照片墙，丰盛的水果甜点，

吸引了众多师生们的驻足，边吃边喝边聊边分享，以从未有过地轻松姿态在这座

天堂般的殿堂里品经典，话人生。 

 

闭幕式上，图书馆馆长王宏光总结了为期一个多月的读书月活动，对策划的

15 场大大小小的活动能得到师生们的大力支持表示感谢，对活动中的用心参与和

反馈表示感动和欣慰，同时寄语自信的上理人勇敢去追逐。来自出版印刷与艺术

设计学院的大四学生王洁同学表达了自己作为一名上理人拥有这样一座温暖图书

馆的骄傲与自豪：丰富的藏书，温馨的环境。这里有她最美的回忆。闭幕式还为

积极参与本届读书月各项活动的获奖师生颁奖。 

最后，副校长田蔚风宣布读书月顺利闭幕。她在讲话中强调，读书月活动的

闭幕并不意味着阅读行为的结束，应借此契机，点燃阅读热情，充分利用图书馆

的馆藏优势，尽享阅读乐趣，使阅读成为上理最富浪漫与温情的一道风景。田副

校长倡议广大师生从自身做起，让终身学习、毕生阅读成为自觉追求，共同打造

书香上理。 

（供 稿：采编部   李婧/ 责任编辑：张  佳） 



 
 

 

                                                                     

征稿启事 

《上海理工大学图书馆通讯》是上海理工大学图书馆馆刊，是展示图书馆工

作和文献信息利用的窗口、沟通读者与图书馆的桥梁。本刊主要设置特稿、图书

馆工作、文献利用、馆员心声（或馆员建言、馆员荐书）、读者沙龙（或你问我答）、

简讯等栏目。请本馆职工和广大读者参与我们的工作，不吝赐稿，把你的体会和

感受写出来，把你的心灵激情和思想火花记下来，让《上海理工大学图书馆通讯》

成为你才智展示的舞台。 

投稿要求： 

来稿体裁形式不限，字数在 300—2000 字均可，也可采用连载方式。 

来稿请注明个人资料，如：真实姓名、发表笔名、所在院系、年级、联系方
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投稿信箱：j_usstlib@usst.edu.cn 
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